
2025

iThesis

iThesis Beginner Guide for
Students & Advisors 

contact@ithesis.co

www.ithesis.co

facebook.com/ithesis.co

youtube.com/@ithesishq

“Digital Companion for Thesis & Research
Management and Beyond”

iThesis Nex-Gen, Rover AI, Paperpilot, and Ecosystem were developed by Facgure Company Limited and its subsidiary. All Rights Reserved. 1

http://www.ithesis.co/
http://www.ithesis.co/


iThesis

วิธีการใช้งานสำหรับ นิสิต/นักศึกษา1.

แผนภาพกระบวนการอนุมัติ โครงร่าง (proposal)2.

แผนภาพกระบวนการอนุมัติฉบับร่าง (draft)3.

แผนภาพกระบวนการอนุมัติฉบับสมบูรณ์  (complete)4.

วิธีการใช้งานสำหรับ อาจารย์ที่ปรึกษา5.
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สารบัญ Outline 

“Digital Companion for
Thesis & Research
Management and

Beyond”

คลิกหัวข้อด้านล่างเพื่อไปยังเนื้อหา



กล่าวโดยสรุป
สำหรับระบบไอทีสิส

ติดตามสถานะการทำวิทยานิพนธ์ของนักศึกษา ตั้งแต่โครงร่างจนถึงฉบับสมบูรณ์

สามารถกำหนดและควบคุมรูปเล่มวิทยานิพนธ์

บันทึกและอัปโหลดไฟล์เป็นเวอร์ชัน  ทำงานร่วมกับ Reference Manager ได้ดี

ตรวจการลักลอกวรรณกรรมผ่านระบบ พร้อมแนบรายงานผลตรวจ

จัดส่งไฟล์และคำขออนุมัติไปยังผู้เกี่ยวข้อง

ไอทีสิส (iThesis) เป็นระบบบริหารจัดการวิทยานิพนธ์และงานวิจัยตั้งแต่เริ่มต้นจนสิ้นสุด 
นักศึกษาสามารถเริ่มต้นเขียนโครงร่างวิทยานิพนธ์ วิทยานิพนธ์ฉบับร่าง และ วิทยานิพนธ์ฉบับสมบูรณ์ 

จัดส่งไปยังอาจารย์ที่ปรึกษาและเจ้าหน้าที่ที่เกี่ยวข้อง รองรับการบันทึกไฟล์งานบนคลาวด์ พร้อมตรวจการ
ลักลอกวรรณกรรม (Plagiarism Check) และส่งไฟล์งานให้อาจารย์ที่ปรึกษาตรวจสอบพร้อมบันทึกผล
การอนุมัติในระบบ และรองรับการเผยแพร่วิทยานิพนธ์เข้าสู่คลังปัญญาของสถาบันการศึกษา

การทำงานร่วมกันระหว่าง นิสิต/นักศึกษา อาจารย์ เจ้าหน้าที่ห้องสมุด เจ้าหน้าที่คณะ
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เป้ าประสงค์ของระบบไอทีสิส

Communication Paperless Digital Tools & Assistant

ระบบไอทีสิส พัฒนาขึ้นเพื่อให้เกิดการ
สื่อสารระหว่าง Advisor/Advisee
มากขึ้น และทำงานวิจัย/วิทยานิพนธ์
ร่วมกัน

การส่งไฟล์วิทยานิพนธ์และการรับ
comment จากอาจารย์จะบันทึกไว้ใน
ระบบตลอดการทำวิจัย

ลดการพิมพ์เล่มวิทยานิพนธ์โดยเริ่ม
ต้นกระบวนการในระบบและสิ้นสุดการ
ทำวิทยานิพนธ์ โดยจัดเก็บในรูปไฟล์
PDF และ DOCX 

มีเครื่องมือสำหรับการจัดทำเล่ม
วิทยานิพนธ์ตลอดทั้งกระบวนการ

มีแนวปฏิบัติที่ดีในการเขียน
วิทยานิพนธ์ และผนวกระบบ
plagiarism check
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นิสิต/นักศึกษา ผู้เรียนระดับบัณฑิตศึกษา

เจ้าหน้าที่บัณฑิตศึกษา

อาจารย์ที่ปรึกษา

ไอทีสิส มีบทบาทผู้ใช้งานเพื่อดูแลและ
กำกับวิทยานิพนธ์ตั้งแต่เริ่มต้น จนสิ้น
สุดเล่มฉบับสมบูรณ์ และนำไปเผย
แพร่

มีการแจ้งเตือนผ่านอีเมลในทุกขั้น
ตอนของการทำวิทยานิพนธ์ สามารถ
ตรวจสอบและเข้าถึงขั้นตอนนั้นได้โดย
คลิกผ่านลิงค์

ข้อมูลผู้ใช้งานจะถูกจัดเตรียมโดยผู้
ดูแลระบบและจัดการสิทธิ์ได้อย่าง
สะดวก

ใช้โปรแกรม iThesis Add-in ซึ่งติดตั้งลงบน Microsoft Word
เพื่อใช้สำหรับเขียนเล่มวิทยานิพนธ์ และใช้ Web Portal เพื่อส่ง
เล่มให้อาจารย์ที่ปรึกษาสำหรับ review หรือ approve 

ดูแลรับผิดชอบ request ที่มาจากนิสิต/นักศึกษา เช่น ขอให้รับรองการ
สอบ proposal การติดตามอนุมัติร่างวิทยานิพนธ์​ (draft) การรับเล่ม
ฉบับสมบูรณ์

ดูแลนิสิต/นักศึกษา ให้คำปรึกษา แนะนำการวิจัย และ review เล่ม
วิทยานิพนธ์แต่ละบท และอนุมัติตามขั้นตอนของบัณฑิตวิทยาลัย

ผู้ใช้งานและบทบาท

contact@ithesis.co www.ithesis.co

เจ้าหน้าที่ห้องสมุด

ใช้เครื่องมือในระบบเพื่อตรวจสอบวิทยานิพนธ์ฉบับใดมีการเผยแพร่ออกสู่
สาธารณะ จะนำส่งไปยัง IR และ TDC 

iThesis 5
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Beginning

นิสิต/นักศึกษา

นิสิต/นักศึกษา

เจ้าหน้าที่บัณฑิตอาจารย์ที่ปรึกษา

Initial Proposal Draft Complete Barcode

นิสิต/นักศึกษาทำความเข้าใจการใช้ไอทีสิส
เครื่องมือที่เกี่ยวข้อง และขั้นตอนการเขียน
วิทยานิพนธ์และส่ง review

นักศึกษาเขียนเล่มวิทยานิพนธ์บทที่ 1-3 เพื่อสอบ
proposal หลังสอบอาจารย์ที่ปรึกษาจะอนุมัติ
proposal

นักศึกษาปรับแก้วิทยานิพนธ์หลังสอบ defense และป้อน
ข้อมูลในระบบเพื่อออกเอกสาร submission document
ส่งให้กับบัณฑิตวิทยาลัย

นักศึกษาทำวิจัยจนแล้วเสร็จและเขียนเล่มวิทยานิพนธ์
บทที่ 4-5 เสร็จสมบูรณ์และส่งขออนุมัติเพื่อสอบ defense

Learning by doing

Develop proposal and Review Complete the Thesis

Finish and Plan for Defense

Planning & proposal Finalization

Research and summary

นักศึกษาส่งเอกสารให้กับบัณฑิต
วิทยาลัย เพื่อทำการ รับเล่มสมบูรณ์
เข้าสู่ระบบและส่งไปเผยแพร่ยัง IR 

Scan Barcode
Release & Publish

Approver

อาจารย์ที่ปรึกษา

Approver

อาจารย์ที่ปรึกษา
Approver

เจ้าหน้าที่บัณฑิต

Approver

กระบวนการในระบบไอทีสิสตั้งแต่ต้นจนจบ
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วิธีการใช้งานสำหรับ 

นิสิต/นักศึกษา
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รับ Username Password สำหรับใช้งานผ่านอีเมลสถาบัน

เตรียม Microsoft Word ติดตั้ง iThesis Add-in

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word

ตรวจสอบ อัปโหลดไฟล์เข้าระบบ และตรวจอักขราวิสุทธิ์

ส่งคำร้องขออนุมัติไปยังอาจารย์ที่ปรึกษา และเจ้าหน้าที่

วิธีการใช้งานสำหรับ 
นิสิต/นักศึกษา

1

2

3

4

5
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กรอกข้อมูลรายงานผลการวิจัยและผลงานตีพิมพ์

ขออนุมัติฉบับร่าง ฉบับสมบูรณ์ และรับเอกสารนำส่ง

6
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Account for iThesis - Email

9

หลังจากเริ่มใช้งานระบบ นักศึกษาจะได้รับอีเมลข้อมูลการ
ล็อกอิน Username และ Password สำ หรับระบบไอทีสิส
จากทางสถาบัน พร้อมขั้นตอนการเข้าใช้งานระบบ

*บางสถาบันอาจใช้งานบัญชีของทางสถาบันเชื่อมต่อกับระบบไอทีสิส
โปรดสอบถามกับเจ้าหน้าที่ผู้ดูแลระบบไอทีสิสของสถาบัน

Username Password นี้สามารถเข้าใช้งานได้ที่

1. iThesis Add-in

2. Web Application

3. Mobile Application

iThesis

1
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วิธีดูเวอร์ชันของ Microsoft Word

File > Account > ดูรุ่นที่  Product Information > ในรูปนี้คือ Microsoft 365

Update version ให้เป็ นปั จจุบัน

กดที่  Update Options > Update Now

รุ่นที่สามารถใช้งานได้
Microsoft 365
Office 2021
Office 2021 LTSC
Office 2019 (Retail Version)

สามารถใช้งานได้ทั้งบน Windows และ macOS เฉพาะ Desktop Version เท่านั้น

iThesis

เตรียม Microsoft Word ติดตั้ง iThesis Add-in2

Microsoft Word ที่สามารถใช้งาน iThesis Add-in ได้

https://help.ithesis.co/portal/en/kb/articles/ms-word-supported-ithesis-office-add-in
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File > Options > Advanced > Cut, copy, and paste > ตั้งค่าให้เป็ น Keep Source Formatting ทุกรายการ > ปิ ดโปรแกรมและเปิ ดใหม่

อ่านเพิ่มเติม เกี่ยวกับการตั้งค่า Keep source formatting

iThesis

การตั้งค่า Microsoft Word ก่อนเริ่มใช้งาน 

เตรียม Microsoft Word ติดตั้ง iThesis Add-in2

https://help.ithesis.co/portal/en/kb/articles/how-to-set-keep-source-formatting-of-cut-copy-paste
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ไปที่  File > Get Add-ins > พิมพ์ “iThesis” ที่ช่องค้นหา > กด Add > กด Continue > เสร็จสิ้ น

สำหรับ Microsoft Word รุ่นอื่น ๆ Add-in อาจอยู่ที่ เมนู  Home หรือ Insert ให้สั งเกตรูปไอคอน 

iThesis

การติดตั้ง iThesis Add-in

เตรียม Microsoft Word ติดตั้ง iThesis Add-in2



13

กด OK > กดปุ่ ม      > จนเจอคำว่า Get Started (ส่วนนี้แสดงเฉพาะการใช้งานครั้งแรก)

iThesis

เตรียม Microsoft Word ติดตั้ง iThesis Add-in2

เริ่มต้นใช้งาน iThesis Add-in



เตรียม Microsoft Word ติดตั้ง iThesis Add-in2

14

Login สำเร็จ

iThesis

การเข้าสู่ระบบ iThesis Add-in 

เข้าสู่หน้า Login เลือกสถาบันใน Institute กรอก Username และ Password
และกดปุ่ ม Login
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กด Tab to sign-in และใช้  Mobile Application สแกน QR code
เพื่อเปิ ดการใช้งาน Co-Creation with AI และ Login via mobile

วิธีการติดตั้ง Paperpilot และการเชื่อมโยงกับบัญชีไอทีสิส

iThesis

iThesis Add-in x Paperpilot Mobile Application 

เตรียม Microsoft Word ติดตั้ง iThesis Add-in2

👈 Scan & download “Paperpilot”

https://help.ithesis.co/portal/en/kb/articles/how-to-link-ithesis-user-with-paperpilot-user


เริ่มต้นสร้างรูปเล่มผ่าน iThesis Add-in

16

ตั้งค่าขอบกระดาษ (Margin) ตามที่กำหนด ตั้งค่าขนาดกระดาษเป็ น A4

Top: 1.5" or 3.81 cm
Left: 1.5" or 3.81 cm
Right: 1" or 2.54 cm
Bottom: 1" or 2.54 cm

iThesis

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3



กรณีกด Generate โดยไม่ได้ตั้งค่าหน้ากระดาษให้ถูกต้องจะพบข้อความนี้
ให้ตรวจสอบว่าตั้งค่าหน้ากระดาษตามที่กำหนดหรือไม่

17

กด Generate > เลือกภาษาเขียนเล่ม (เฉพาะครั้งแรกที่ ใช้งาน) > Confirm 

iThesis

เริ่มต้นสร้างรูปเล่มผ่าน iThesis Add-in (ต่อ)

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3
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คลิกที่กล่องข้อความ หากแสดงสี เขียวแปลว่าสามารถแก้ไขได้  เมื่อพิมพ์ข้อความจะกลายเป็ นสีส้ม (สี เปลี่ยนเมื่อเปิ ด Add-in เท่านั้น)

กล่องข้อความหากเป็ นสี เทาจะไม่สามารถแก้ไขข้อความ
เนื่องจากเป็ นส่วนที่ระบบจัดเตรียมข้อมูลให้

iThesis

การกรอกข้อมูลลงในรูปเล่มที่สร้างขึ้น
สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3



หน้าปก - ชื่อหัวข้อภาษาไทย กับ ชื่อหัวข้อภาษาอังกฤษ 
บทคัดย่อ - กรอกคำสำ คัญกับเนื้อหาบทคัดย่อ 
กิตติกรรมประกาศ - เนื้อหาของกิตติกรรมประกาศ
ประวัติผู้เขียน - กรอกข้อมูลตามรูปแบบที่สถาบันกำหนด

19

ข้อมูลในหน้าเหล่านี้จะเชื่อมโยงกับข้อมูลบนระบบไอทีสิส โดยสามารถ
แก้ไขและอัปเดตไปยังระบบไอทีสิสได้  จำเป็ นจะต้องอัปเดตข้อมูลใน
เอกสารให้ตรงกับบนระบบก่อนจึงจะสามารถบันทึกไฟล์เข้าระบบได้

สำ หรับเอกสารที่มีข้อมูลคณะกรรมการสอบ อาจารย์ที่ปรึกษา 
ให้เพิ่มรายชื่อผ่านเมนู  Form ที่  iThesis Add-in 
โดยดูวิธีการได้ที่หัวข้อ “การเพิ่มชื่อคณะกรรมการสอบ”

หากแก้ไขข้อมูลแล้วไม่อัปเดต ระบบจะไม่ยอมให้บันทึกโดยแสดงหน้าจอนี้

ข้อควรระวัง
ไม่สามารถวางและบันทึกสมการที่สร้างจาก Equation ของ Microsoft Word ที่กล่องข้อความที่ เชื่อมโยงกับระบบได้
สัญลักษณ์บางรายการ การแสดงผลขึ้นกับรูปแบบอักษรที่ เลือกใช้งาน และความสามารถในการบันทึกเข้าสู่ ฐานข้อมูล

iThesis

ข้อมูลในรูปเล่มที่เชื่อมโยงกับระบบไอทีสิส

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3
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อัปเดตข้อมูลโดยการคลิกที่กล่องข้อความที่ เป็ นสีส้ม จากนั้นกดปุ่ ม Update เมื่อบันทึกสำ เร็จกล่องข้อความจะเปลี่ยนเป็ นสี เขียว

กระบวนการนี้ เป็ นการอัปเดตข้อมูลเข้าระบบทีละส่วน หากต้องการอัปเดตในคราวเดียวให้กด Validate template เพื่อตรวจสอบข้อมูล
และอัปเดต ทั้งนี้กระบวนการนี้ยังไม่ใช่การบันทึกไฟล์เข้าสู่ ระบบ

iThesis

การอัปเดตข้อมูลเข้าระบบผ่าน iThesis Add-in

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3
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บริเวณที่ เริ่มเขียนเนื้อหาในเทมเพลตจะมีคำว่า “เริ่มเขียนบทที่  1 ที่นี่ ” กดเปิ ด Paragraph Mark หรือ      เพื่อให้เห็น Section Break 
สามารถนำเนื้อหาที่ ได้จัดทำไว้แล้วที่ ไฟล์อื่นมาวางที่นี่ ได้  หรือเริ่มต้นพิมพ์ที่บริเวณนี้  โดยระวังไม่ไปลบ Section Break ออก

การใช้งานจัดทำรูปเล่มในส่วนเนื้อหา รวมไปถึงสารบัญ โดยสามารถใช้งานฟั งก์ชันต่าง ๆ ของ Microsoft Word ได้

รูปเล่มสามารถใช้งานควบคู่กับโปรแกรมจัดทำรายการอ้างอิง (Reference Manager) โดยแนะนำให้ใช้งาน Mendeley Cite

iThesis

เริ่มเขียน/วางเนื้อหาในรูปเล่ม

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3
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เลือก Form > กด Add Committee & Examiner > เลือก Committee Type > พิมพ์ชื่ออาจารย์แล้วเลือกจากรายชื่อที่แสดง

**สามารถเลือกชื่อคณะกรรมการสอบได้จากที่มี ในระบบเท่านั้น หากไม่พบชื่อให้ติดต่อผู้ดูแลระบบประจำสถาบันเพื่อเพิ่มรายชื่อ**

iThesis

การเพิ่มชื่อคณะกรรมการสอบ

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3
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เพิ่มคำนำหน้า (Prefix Name) และคำลงท้าย (Postfix Name)
โดยกด Add Data > เลือกคำที่ต้องการเพิ่ม > กด Add

ตรวจสอบรูปแบบชื่อ > เลื่อนมาด้านล่าง > กด Save เพื่อบันทึกรายชื่อ 
เพิ่มรายชื่อกรรมการท่านอื่น ๆ ด้วยวิธีเดียวกันจนครบถ้วน

กดที่รูป     เพื่อแก้ไขข้อมูลของกรรมการ

กดที่รูป     เพื่อลบรายชื่อกรรมการ

**เมื่อปรับปรุงรายชื่อคณะกรรมการแล้วจำเป็ นจะต้องกด Generate Template เพื่อให้รายชื่อในรูปเล่มอัปเดตด้วย**

iThesis

การเพิ่มชื่อคณะกรรมการสอบ (ต่อ)

สร้างรูปเล่มและจัดรูปเล่มเอกสารด้วย Microsoft Word3
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กด Validate Template > หากมีข้อมูลที่ ไม่ตรงกับบนระบบจะแสดงข้อความที่  Validate Results > กด See details 

สามารถกด Update All เพื่ออัปเดตข้อมูลในรูปเล่มเข้าสู่ ระบบในคราว
เดียว กด Update อีกครั้ง และรอระบบอัปเดตข้อมูล

หากข้อมูลในรูปเล่มตรงกับบนระบบแล้ว กด Validate Template 
จะแสดงข้อความนี้ที่ด้านล่างของหน้าจอ iThesis Add-in
แสดงว่าสามารถบันทึกเข้าสู่ ระบบ (Save to Cloud) ได้แล้ว

iThesis

การตรวจสอบข้อมูลในรูปเล่ม (Validate template)

4 ตรวจสอบ อัปโหลดไฟล์เข้าระบบ และตรวจอักขราวิสุทธิ์
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กดปุ่ ม Save to Cloud > รอสักครู่ (อาจใช้ระยะเวลานานหากไฟล์มีขนาดใหญ่) > จะพบกับหน้าจอแสดงข้อมูล > กด Save 

เมื่อบันทึกสำ เร็จจะมีรายการไฟล์
แสดงที่  Revision & Feedback

iThesis

การบันทึกไฟล์เข้าสู่ระบบ (Save to Cloud)

4 ตรวจสอบ อัปโหลดไฟล์เข้าระบบ และตรวจอักขราวิสุทธิ์
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ตรวจสอบที่  Revision & Feedback คลิกที่รายการไฟล์ที่บันทึก > กด PDF > กด Open file

รายการที่บันทึกเข้าสู่ ระบบจะยังไม่ถูกส่งให้กับอาจารย์ที่ปรึกษา 
จะต้องไปดำเนินการส่งคำร้องผ่านระบบที่  iThesis Web Portal

การบันทึกไฟล์เข้าสู่ ระบบ จะได้ไฟล์เล่มรูปแบบ PDF ที่มีบาร์โค้ดแสดงเวอร์ชันของไฟล์  ซึ่งเป็ นไฟล์ที่อาจารย์ที่ปรึกษาจะได้รับเมื่อนักศึกษาส่งขออนุมัติในระบบ
ให้นักศึกษาตรวจสอบไฟล์  PDF ที่ระบบสร้างขึ้นก่อนส่งคำร้องให้อาจารย์ที่ปรึกษา หากต้องแก้ไขให้ดำเนินการแก้ไขจากไฟล์  Word ที่ เปิ ดอยู่  และ Save to
Cloud อีกครั้งได้ตามต้องการ

iThesis

การตรวจสอบไฟล์ที่บันทึกแล้ว
4 ตรวจสอบ อัปโหลดไฟล์เข้าระบบ และตรวจอักขราวิสุทธิ์



คลิกที่รายการไฟล์ที่บันทึก > กด Check > เลือก                   > รอจนระบบตรวจเสร็จ 

27

ก่อนจะสามารถส่งคำร้องให้กับอาจารย์ที่ปรึกษา นักศึกษาจะต้องเลือก Check Plagiarism หรือตรวจลักลอกวรรณกรรมก่อน โดยสำหรับ
ระบบไอทีสิสจะให้ตรวจอักขราวิสุทธิ์ก่อน

(ช่วงที่มีการใช้งานเยอะอาจใช้ระยะเวลาตรวจนาน)

ไปส่งคำร้องกัน

iThesis

การตรวจลักลอกวรรณกรรมผ่าน iThesis Add-in

4 ตรวจสอบ อัปโหลดไฟล์เข้าระบบ และตรวจอักขราวิสุทธิ์
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การส่งคำร้องจะต้องดำเนินการที่  iThesis Web Portal โดยสามารถกดที่คำว่า Web Portal ภายใต้เมนูของ Add-in 

ใช้  Username Password เดียวกันกับที่ ใช้งานที่  iThesis Add-in

iThesis

การส่งคำร้องที่ iThesis Web Portal

5 ส่งคำร้องขออนุมัติไปยังอาจารย์ที่ปรึกษา และเจ้าหน้าที่



5
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Login แล้วจะพบกับหน้าแสดงข้อมูลนักศึกษา > กดที่  Revision & Approval > เลือกไฟล์ที่ต้องการส่ง กด Save Proposal

ไฟล์ที่จะสามารถเลือก save proposal ได้  จะต้องตรวจอักขราวิสุทธิ์เรียบร้อยแล้วเท่านั้น

iThesis

หากพบว่ามีไฟล์แต่ไม่สามารถเลือก
ได้  อาจเกิดจากการแก้ไขข้อมูลหลัง
จากบันทึกไฟล์เข้าระบบ 

โดยสามารถสังเกตได้จากวันที่อัป
โหลดไฟล์  จะต้องมากกว่า Last
update on electronic form จึงจะ
สามารถเลือกส่งขออนุมัติได้

Revision & Approval และ Save Proposal

ส่งคำร้องขออนุมัติไปยังอาจารย์ที่ปรึกษา และเจ้าหน้าที่

เลือกไฟล์

กด Save Proposal
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ระบบจะแสดงคำว่า Pending โดยนักศึกษาสามารถตรวจสอบ
สถานะได้ทั้งจาก Approval Status ได้ที่ เมนู  Electronic
Form หรือรับการแจ้งเตือนผ่านทางอี เมล

iThesis

เมื่อส่งคำร้องแล้วนักศึกษายังสามารถแก้ไขเนื้อหาในรูปเล่มได้  แต่จะไม่สามารถแก้ไขข้อมูลที่ เชื่อมโยงกับระบบได้ระหว่างที่ขออนุมัติ

5 ส่งคำร้องขออนุมัติไปยังอาจารย์ที่ปรึกษา และเจ้าหน้าที่
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นักศึกษาสามารถติดตามการอนุมัติของอาจารย์ที่ปรึกษา และเจ้าหน้าที่ ได้ทั้งทางอี เมล และที่หน้าเมนู  Revision & Approval
หากอาจารย์ไม่อนุมัติ ให้ผ่าน นักศึกษาสามารถกดที่ ไฟล์  PDF (annotation) ได้เพื่อดูความคิดเห็น รวมไปถึงสามารถโหลด
Attach file ได้หากอาจารย์มีการแนบมา 

iThesis

การตรวจสอบไฟล์เมื่ออาจารย์ที่ปรึกษาให้กลับมาแก้ไข

5 ส่งคำร้องขออนุมัติไปยังอาจารย์ที่ปรึกษา และเจ้าหน้าที่



นักศึกษาส่ง
คำร้อง

ไม่อนุมัติ ไม่อนุมัติ

อาจารย์ที่ปรึกษา
พิจารณา

เจ้าหน้าที่บัณฑิต
ศึกษาพิจารณา

นักศึกษาอัปโหลด
เล่มเข้าระบบ

ผ่าน Proposal

นักศึกษาแก้ไขรูป
เล่ม

นักศึกษาจัดทำ
รูปเล่ม

32

อนุมัติ  อนุมัติ  

หลังจากนักศึกษาได้รับอนุมัติโครงร่างจากต้นสังกัดแล้ว
นักศึกษานำไฟล์ที่มี  มาจัดทำรูปเล่มมาจัดทำผ่านระบบไอทีสิส
นักศึกษาดำเนินการศึกษาวิจัยตามกระบวนการ รวบรวมข้อมูลวิจัย 
จัดทำรูปเล่มผ่าน iThesis Add-in จนมีเนื้อหาครบ 5 บท หรือตาม
ข้อกำหนดของสถาบัน
ทำการอัปโหลดเพื่อขออนุมัติฉบับร่าง (Draft) ต่อไป

iThesis

กระบวนการจัดทำเล่มและขออนุมัติโครงร่าง (Proposal)
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6 กรอกข้อมูลรายงานผลการวิจัยและผลงานตีพิมพ์

การกรอกข้อมูลรายงานผลการวิจัย (Report Data)
จะเป็ นการกรอกข้อมูลเพื่อนำไปสร้างเอกสารนำส่ง หรือ Submission Document โดยจะต้องกรอกข้อมูลให้ครบถ้วนสำหรับหัวข้อที่จำเป็ นต้อง
กรอก จึงจะสามารถส่งเล่มสมบูรณ์ผ่านระบบไอทีสิสได้  

Plagiarism Detection: 
สำหรับการแนบผลตรวจเป็ นรายงาน จะขึ้นกับการตั้ง
ค่าของสถาบัน โดยหากจำเป็ นต้องแนบจะต้องนำรูป
เล่มไปตรวจด้วยโปรแกรมอื่น และนำไฟล์  PDF ที่ ได้
กลับมาแนบพร้อมกรอก % 
สำ หรับ Akarawisut ระบบจะเติมให้เองโดยอัตโนมัติ

นักศึกษากรอกข้อมูลในส่วนนี้ตามจริง 
Evaluation - ผลประเมินการสอบปกป้ อง
Dissemmination - การเผยแพร่รูปเล่มวิจัยที่จัดทำ
ด้วยระบบไอทีสิส

After Defense (จำเป็ นต้องกรอก)
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6 กรอกข้อมูลรายงานผลการวิจัยและผลงานตีพิมพ์

การกรอกข้อมูล Research Mapping 
ใช้สำ หรับการระบุข้อมูลสาขาวิจัย
มาตรฐานอุตสาหกรรม รวมไปถึง
มาตรฐานการศึกษาให้กับเอกสารวิจัยที่
นักศึกษาจัดทำ 
เพื่อให้การเผยแพร่ผลงานของนักศึกษา
สามารถถูกค้นหาได้ตามขอบเขตที่กำหนด 
โดยนักศึกษาสามารถปรึกษาการกรอก
ข้อมูลส่วนนี้กับอาจารย์ที่ปรึกษาได้

Research Mapping (จำเป็ นต้องกรอก)

การกรอกข้อมูลรายงานผลการวิจัย (Report Data)
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6 กรอกข้อมูลรายงานผลการวิจัยและผลงานตีพิมพ์

กรณีที่มีผลงานอันเป็ นส่วนหนึ่งของการศึกษาวิจัย สามารถบันทึกผลงานตีพิมพ์ได้ผ่านเมนู  Publication 
Real time search - ตัวช่วยค้นหางานวิจัยที่ เผยแพร่แล้ว แนะนำนักศึกษาให้ใช้เมนูนี้หากผลงานตีพิมพ์เผยแพร่แล้ว
Publication Form - ใช้สำ หรับกรอกข้อมูลผลงานตีพิมพ์ด้วยตนเอง สำ หรับนักศึกษาที่ ได้ตอบรับผลงานตีพิมพ์แล้ว 

การกรอกข้อมูลผลงานตีพิมพ์รูปแบบวารสาร จำเป็ นจะต้องเลือกวารสารที่มี ในระบบเท่านั้น สามารถแจ้งเพิ่มรายชื่อวารสารได้ที่ผู้ดูแลระบบ

Publication (ขึ้นกับข้อกำหนดของสถาบัน)

การกรอกข้อมูลรายงานผลการตีพิมพ์ (Publication)



การส่งคำขออนุมัติฉบับร่าง (Draft) 
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Revision & Approval > เลือกไฟล์ที่ต้องการส่ง กด Save as Draft Version

ข้อควรระวัง: บางสถาบันอาจตั้งค่าให้สามารถ
ขอแก้ไขโครงร่างได้  โดยจะมีข้อความแสดงเช่นนี้
ให้ระมัดระวังในการส่งอนุมัติ  

iThesis

7 ขออนุมัติฉบับร่าง ฉบับสมบูรณ์ และรับเอกสารนำส่ง



นักศึกษาส่ง
คำร้อง

อาจารย์ที่ปรึกษา
พิจารณา

ผ่าน Draftนักศึกษาอัปโหลด
เข้าระบบ

นักศึกษาแก้ไขรูป
เล่ม

ดำเนินการสอบ
ปกป้ อง/นำเสนองาน

วิจัย

นักศึกษาจัดทำ
รูปเล่ม
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เมื่อนักศึกษาจัดทำเนื้อหางานวิจัยจนมีเนื้อหาครบถ้วน พร้อมที่จะดำเนินการขอสอบปกป้ อง
(defense) 

จัดทำรูปเล่มผ่าน iThesis Add-in ให้มีรูปแบบและเนื้อหาตามเอกสารวิจัยฉบับสมบูรณ์  
ให้ทำการอัปโหลดเพื่อขออนุมัติฉบับร่าง (Draft) ต่อไป 

ภายหลังจากที่ได้รับอนุมัติฉบับร่างนี้แล้ว 
นักศึกษานำไฟล์ที่ ได้จากระบบไปดำเนินการสอบปกป้ อง/นำเสนอตามกระบวนการของทางสถาบัน

หากจำเป็ นต้องปรับแก้ชื่อหัวข้อวิจัยหลังจากผ่านโครงร่าง ให้ดำเนินการส่งคำร้องผ่านระบบไอทีสิส

iThesis

ไม่อนุมัติ

อนุมัติ  

กระบวนการจัดทำเล่มและขออนุมัติฉบับร่าง (Draft) 



1

38

เข้าสู่ ระบบ > Electronic form > Request to edit topic > พิมพ์ชื่อหัวข้อที่ต้องการที่  New topic > กด Send Request

ระบบไอทีสิสมีข้อกำหนดว่า หลังจากนักศึกษาได้รับอนุมัติโครงร่าง (proposal) แล้ว การเปลี่ยนชื่อหัวข้อวิจัยจะต้องส่งคำร้องขอแก้ไข

นักศึกษารออาจารย์ที่ปรึกษาและเจ้าหน้าที่อนุมัติ

iThesis

การขอแก้ไขชื่อหัวข้อวิจัยหลังผ่าน Proposal

2

3



อาจารย์ที่ปรึกษา
พิจารณา

เจ้าหน้าที่บัณฑิต
ศึกษาพิจารณา

นักศึกษากรอกแบบฟอร์ม
ขอแก้ไขชื่อหัวข้อ

นักศึกษากลับไปอัปเดตชื่อหัวข้อ
ที่ เอกสาร (จะสามารถบันทึกได้)

Edit Topic
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คลิกเพื่อดูวีดีโอ

เมื่อคำร้องขอแก้ไขหัวข้อได้รับอนุมัติแล้ว ให้นักศึกษาทำการ login ที่  iThesis Add-in และอัปเดตชื่อหัวข้อใหม่โดยกด Retrieve

iThesis

อนุมัติ  อนุมัติ  

ไม่อนุมัติ ไม่อนุมัติ

การขอแก้ไขชื่อหัวข้อวิจัยหลังผ่าน Proposal (ต่อ)

https://youtu.be/hhrr8_vYQYs?si=LbEJioG9VirCg6jF


การส่งคำขออนุมัติฉบับสมบูรณ์ (Complete) 
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Revision & Approval > เลือกไฟล์ที่ต้องการส่ง กด Save as Complete Version

หาก save complete แล้วพบข้อความนี้  
แสดงว่ายังไม่ได้กรอกข้อมูล Report Data หัวข้อย่อย After defense และ
Research Mapping จะต้องไปกรอกให้ครบถ้วนก่อน

iThesis

อาจพบข้อความนี้ด้วยหากสถาบันมีการตั้งค่าให้นักศึกษากรอกข้อมูล
ผลงานตีพิมพ์ หรือ Publication ก่อน ถึงจะสามารถส่งเล่มสมบูรณ์ ได้  

7 ขออนุมัติฉบับร่าง ฉบับสมบูรณ์ และรับเอกสารนำส่ง
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ดาวน์ โหลด Submission
Document ลงนาม และ
นำส่งเอกสารผ่านช่อง

ทางที่กำหนดโดยสถาบัน

นักศึกษาส่ง
คำร้อง

อาจารย์ที่ปรึกษา
พิจารณา

ผ่าน Completeนักศึกษาอัปโหลดเข้า
ระบบ

อนุมัติ  

นักศึกษาแก้ไขรูปเล่ม

เมื่อนักศึกษาสอบปกป้ อง/นำเสนองานวิจัยฉบับสมบูรณ์เรียบร้อยแล้ว 
ได้รับข้อคิดเห็นจากคณะกรรมการให้แก้ไขรูปเล่ม
ดำเนินการแก้ไขจนแล้วเสร็จ และบันทึกไฟล์เข้าสู่ ระบบไอทีสิส 
กรอกข้อมูล Report Data ให้ครบถ้วน จึงจะส่งขออนุมัติรูปเล่มฉบับสมบูรณ์ ได้

เมื่อได้รับอนุมัติรูปเล่มฉบับสมบูรณ์แล้วจะได้รับ
รูปเล่มฉบับสมบูรณ์  (complete version) 
เอกสารนำส่ง (submission document) 

นักศึกษาจัดทำรูปเล่ม

iThesis

ไม่อนุมัติ

กระบวนการจัดทำเล่มและขออนุมัติฉบับสมบูรณ์ (complete)



7

หากไม่มีแก้ไขรูปเล่มฉบับสมบูรณ์อีกจะถือว่าเสร็จสิ้นกระบวนการ
ของระบบไอทีสิสแล้ว

เล่มฉบับสมบูรณ์ + เอกสารนำส่ง
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เมื่อนักศึกษาได้รับอนุมัติรูปเล่มฉบับสมบูรณ์แล้ว ให้ดาวน์ โหลดเอกสารที่ ได้ ไปดำเนินการขอลงนาม และนำส่งกับสถาบันต่อไป

Published Version มีลายน้ำ ของสถาบัน

เอกสารนำส่ง Submission Document

Complete Version มีบาร์โค้ดที่หน้าปกเมื่อได้รับอนุมัติฉบับสมบูรณ์แล้ว

iThesis

ขออนุมัติฉบับร่าง ฉบับสมบูรณ์ และรับเอกสารนำส่ง



อาจารย์ที่ปรึกษา
พิจารณา

เจ้าหน้าที่บัณฑิต
ศึกษาพิจารณา

นักศึกษากรอกแบบฟอร์ม
ขอแก้ไขฉบับสมบูรณ์

นักศึกษาแก้ไขรูปเล่มและอัป
โหลดเข้าระบบ

Revise Complete

นักศึกษาส่งคำร้องขออนุมัติ
Complete
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หากจำเป็ นต้องแก้ไขรูปเล่มที่ ได้รับอนุมัติฉบับสมบูรณ์ ไปแล้ว
กรอกคำร้องขออนุมัติการแก้ไขฉบับสมบูรณ์  จะมีอี เมลคำร้องส่งไปหาอาจารย์ที่ปรึกษา
และเจ้าหน้าที่บัณฑิตศึกษา
เมื่ออาจารย์ที่ปรึกษาและเจ้าหน้าที่บัณฑิตศึกษาอนุมัติแล้วสถานะ Complete จะถูกนำออก 
ให้นักศึกษาดำเนินการนำเล่มเข้าระบบไอทีสิสและขออนุมัติฉบับสมบูรณ์อีกครั้ง

Revise Completed Version จะปรากฏเมื่อได้รับอนุมัติ
Complete แล้ว

iThesis

จำเป็ นจะต้องดาวน์ โหลดเอกสารนำส่ง (submission document) ใหม่
เนื่องจากเลขบาร์โค้ดจะเปลี่ยนแปลงเล่มที่ ได้รับอนุมัติ

อนุมัติ  อนุมัติ  

ไม่อนุมัติ ไม่อนุมัติ

การแก้ไขฉบับสมบูรณ์ (Revise Complete Version)
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รับบัญชี ใช้งานนักศึกษาผ่านอี เมลสถาบัน
เตรียม Microsoft Word + iThesis Add-in

ระบุข้อมูลจำเป็ นตามรูปเล่ม รวมถึงรายชื่อคณะกรรมการ
สอบจัดทำรูปเล่มวิจัย ตรวจสอบ และบันทึกเข้าสู่ ระบบ

ตรวจลักลอกวรรณกรรม
ส่งคำร้องไปยังผู้อนุมัติ  (อาจารย์ที่ปรึกษา + เจ้าหน้าที่ )

กรอกข้อมูล Report Data และ Publication

ลงนามในเอกสารที่ ได้ภายหลังจากผ่านการอนุมัติฉบับสมบูรณ์

สรุปกระบวนการที่สำคัญในระบบไอทีสิส สำหรับนักศึกษา
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วิธีการใช้งานสำหรับ 

อาจารย์ที่ปรึกษา

iThesis



ตรวจสอบรูปเล่มจากคำร้องที่นิสิต/นักศึกษาส่งขออนุมัติ

ให้ความคิดเห็นกับคำร้อง (อนุมัติ/ไม่อนุมัติ)

วิธีการใช้งานสำหรับ 
อาจารย์ที่ปรึกษา

1

2

3iThesis

การตรวจสอบเอกสารนำส่งฉบับสมบูรณ์3



ตรวจสอบรูปเล่มจากคำร้องที่นิสิต/นักศึกษาส่งขออนุมัติ1

การเข้าถึงหน้าอนุมัติของอาจารย์ที่ปรึกษา
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เมื่อนักศึกษามีการส่งคำร้องขออนุมัติ  อาจารย์จะได้รับอี เมลที่สามารถเข้าสู่ หน้าอนุมัติได้

อาจารย์ที่ปรึกษาจะได้รับอี เมลจากทุกกระบวนการอนุมัติ : โครงร่าง, ฉบับร่าง, ฉบับสมบูรณ์ , ขอแก้ไขหัวข้อ และขอแก้ไขฉบับสมบูรณ์

iThesis

Click ที่ปุ่ มสี เหลือง เพื่อเข้าหน้าอนุมัติ

Click ที่  link 
เพื่อเข้าหน้าอนุมัติ

Email

iThesis Web Portal 

รับ username password จากผู้ดูแลระบบเพื่อเข้าใช้งาน
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หน้าอนุมัติของอาจารย์ที่ปรึกษา
ส่วนของ Approval Form

iThesis

การแนบไฟล์ PDF สามารถทำได้เฉพาะอาจารย์ที่ปรึกษาหลัก (advisor) สามารถแนบได้ 
1 ไฟล์ โดยเลือกที่ Choose File ซึ่งจะแนบได้เฉพาะการเลือก “ไม่อนุมัติ / disapprove ”
เท่านั้น

ตรวจสอบรูปเล่มจากคำร้องที่นิสิต/นักศึกษาส่งขออนุมัติ1

1. ไฟล์ที่นักศึกษาจัดทำทั้ง Word, PDF และมี  PDF annotation  

2. ผลตรวจลักลอกวรรณกรรมด้วยโปรแกรมอักขราวิสุทธิ์  

3. ไฟล์แนบเพิ่มเติมจากนักศึกษา (ไม่บังคับ)  

4. ข้อความที่นักศึกษาส่งมา  

 5. เมนู เพื่อพิจารณาอนุมัติ  โดยหากอาจารย์ต้องการให้
นักศึกษากลับไปแก้ ไขงาน จะต้องเลือก Disapprove พร้อม
ระบุข้อคิดเห็น และสามารถแนบไฟล์เพิ่มเติมได้  

  กดเพื่อยืนยันการอนุมัติ
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การใช้งาน Annotation
ควรใช้งานฟี เจอร์นี้ผ่าน Web Browser 
กดที่  annotation จะเปิ ดไฟล์  PDF ขึ้นมา

ทำการเลือกข้อความและพิมพ์ข้อคิดเห็น จากนั้นกดที่รูปดินสอเพื่อบันทึกข้อคิดเห็น

ความคิดเห็นในไฟล์นี้จะอยู่ ในระบบ และนักศึกษาจะสามารถเห็นได้หลังจากได้รับอนุมัติหรือไม่อนุมัติ  

iThesis

หากพบข้อความ Across Pages annotation is not
supported. แสดงว่ามีการเลือกข้อความข้ามหน้า ให้กด ok
แล้วเลือกข้อความใหม่อีกครั้ง 

ให้ความคิดเห็นกับคำร้อง (อนุมัติ/ไม่อนุมัติ)2



การตรวจสอบเอกสารนำส่งฉบับสมบูรณ์3
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Submission Document

iThesis

นอกจากการตรวจสอบไฟล์เล่มสมบูรณ์  (final) แล้ว จะต้องตรวจสอบเอกสารนี้
ก่อนจะกดอนุมัติฉบับสมบูรณ์ ให้นักศึกษา โดยให้ตรวจสอบตามรายการดังนี้

Thesis Committee - ตำแหน่งวิชาการ ชื่อ วุฒิการศึกษา
Research mapping - หัวข้อที่ เลือกตรงกับงานวิจัยที่จัดทำ
Report on publication - หากนักศึกษามีผลงานตีพิมพ์ และมีข้อกำหนดว่าจะต้องตี
พิมพ์ก่อนจะส่งเล่มสมบูรณ์จะต้องมีการกรอกข้อมูลในส่วนนี้
Certification - กรณีมีแนบผลตรวจลักลอกวรรณกรรมจากโปรแกรมอื่นจะมีการก
รอกข้อมูลในส่วนนี้

ภายหลังจากอาจารย์กดอนุมัติเล่มสมบูรณ์แล้ว นักศึกษาจะนำไฟล์เอกสารฉบับนี้มา
ให้อาจารย์ลงนาม ก่อนจะนำส่งทั้งเล่มสมบูรณ์และเอกสารนำส่งนี้กับบัณฑิต
วิทยาลัยต่อไป

ข้อมูล (no data) และ (not found complete thesis) จะแสดงเมื่ออาจารย์อนุมัติฉบับสมบูรณ์

จำนวนหน้าของเล่มฉบับสมบูรณ์

บาร์โค้ด

วันที่อนุมัติ  ภาคการศึกษาและปี การศึกษา ผลตรวจอักขราวิสุทธิ์ของไฟล์ฉบับสมบูรณ์

เมื่อนักศึกษาส่งคำร้องขออนุมัติรูปเล่มฉบับสมบูรณ์  อาจารย์ที่ปรึกษา
จะพบว่ามีไฟล์เอกสาร Advisee’s Submission Document หรือ
เอกสารนำส่งของนักศึกษาในรายการด้วย



การตรวจสอบเอกสารนำส่งฉบับสมบูรณ์3
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Submission Document (Approved)

iThesis

เมื่ออาจารย์อนุมัติแล้วจะมีรายการไฟล์  ชื่อ
complete เพิ่มมา (หน้าแรกสุดจะมีเลข
บาร์โค้ดเดียวกันกับ submission
document) 
เอกสารนี้ เป็ นฉบับนักศึกษาใช้นำส่งบัณฑิต
วิทยาลัยควบคู่กับเอกสารนำส่ง

โดยการดำเนินการของอาจารย์ในระบบไอทีสิสจะเสร็จสิ้ นต่อเมื่อลงนามในเอกสารนำส่งและนักศึกษานำส่งเอกสารให้กับบัณฑิตวิทยาลัย
(หรืออาจเป็ นหน่วยงานอื่นตามข้อกำหนดของแต่ละสถาบัน) 



THANK YOU

contact@ithesis.co

www.ithesis.co

facebook.com/ithesis.co

youtube.com/@ithesishq

Dr. Nappaphan Kunanusont
nappaphan.k@facgure.com, 0816112321

Theerayooth Kosin
theerayooth.k@facgure.com, 0892915831

iThesis

52


